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Introduction

PCIC3B3 2007 includes 6 quizzes.  The PCIC3B3 2007 Guide – Course Quizzes includes the text of the questions, choices and correct answers for these quizzes. The student's score is recorded each time the quiz is taken. Students may review the quiz questions to see the correct answers and/or retake each quiz as many times as desired. Teknimedia's management system saves the first and last score each student receives for each quiz.

B1.23  Quiz 1-1

Note:  The correct answer for each question is underlined.

1.  What is Microsoft PowerPoint?

TYPE: Multiple Choice

ANSWER: It is the latest operating system made by Microsoft.

ANSWER: It is a spreadsheet application program which lets you process and present data for a variety of purposes.

ANSWER: It is a presentation application program that lets you create presentations for a variety of purposes, such as sales reports, business plans, and school projects.

ANSWER: It is an advanced word processing application program best suited for writing multi-chapter books.

2.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: The Ribbon organizes PowerPoint's functions.

ANSWER: The Ribbon's default tab is the "View" tab.
ANSWER: The Ribbon replaces menus and toolbars in previous versions of PowerPoint.

ANSWER: You can hide the Ribbon's functions by double-clicking on the active tab.

3.  In this picture, what will happen if you click on the button that the red arrow is pointing to?

TYPE: Multiple Choice

[image: image2.png]Drawing




ANSWER: The "Paragraph" dialog box will open.
ANSWER: A new tab labeled "Paragraph" will be added to the Ribbon.

ANSWER: The "Paragraph" function group will disappear from the Ribbon.

ANSWER: Nothing

4.  In this picture, what is the name of the area marked in yellow?

TYPE: Multiple Choice
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ANSWER: Slide Pane

ANSWER: Notes Pane

ANSWER: Status Bar

ANSWER: Task Pane

5.  In this picture, what is the name of the area marked in yellow?

TYPE: Multiple Choice
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ANSWER: Slide Pane

ANSWER: Notes Pane

ANSWER: Status Bar

ANSWER: Task Pane

6.  In this picture, what is the role of the small circles around the placeholder?

TYPE: Multiple Choice
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ANSWER: They help you see the placeholder's boundaries.

ANSWER: They let you move the placeholder.

ANSWER: They let you resize the placeholder.

ANSWER: They let you draw a line around the placeholder by connecting the circles.

7.  When typing text in a bulleted placeholder, how can you start a new bullet on the next line?

TYPE: Multiple Choice

ANSWER: Press the Enter key.

ANSWER: Press the "Down Arrow" key on the keyboard.

ANSWER: Click on the "Down Arrow" button on the scroll bar.

ANSWER: Click on the "Double Down Arrow" button on the scroll bar.

8.  In this picture, what will happen if you click on the bottom part of the button the red arrow is pointing to?

TYPE: Multiple Choice
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ANSWER: A new slide will be added to the presentation.

ANSWER: The gallery of slide layouts will be displayed.
ANSWER: A blank slide will replace the current one.

ANSWER: A dialog box will appear asking you if you're sure you want to insert a new slide.
9.  To move between slides, you can use any of the following except one. Which one does not allow you to move between slides?

TYPE: Multiple Choice

ANSWER: Pressing the Up and Down Arrow keys on the keyboard.

ANSWER: Clicking on the Up and Down Double Arrow buttons on the scroll bar.

ANSWER: Pressing the Enter and Tab keys on the keyboard.

ANSWER: Pressing the Left and Right Arrow keys on the keyboard.

10.  Which view type is best suited for previewing your presentation the way it appears to the audience?

TYPE: Multiple Choice

ANSWER: Normal

ANSWER: Slide Show

ANSWER: Slide Sorter

ANSWER: Zoom

11. Which view type gives you an overall picture of the presentation, and lets you easily reorder, add, or delete slides?

TYPE: Multiple Choice

ANSWER: Normal

ANSWER: Slide Show

ANSWER: Slide Sorter

ANSWER: Zoom

12.  This is a picture of slide 3 in a presentation. Where do you have to click to go directly to slide 5?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: D

13. All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can enter text in a placeholder.

ANSWER: You can change a placeholder's height.

ANSWER: When you resize a placeholder filled with text, the text's size does not change.

ANSWER: The first slide in the presentation contains placeholders for entering a title and a subtitle.

14.  When you are in the middle of typing a paragraph and the text reaches the right edge of the placeholder, you should:

TYPE: Multiple Choice

ANSWER: continue typing.

ANSWER: press the Enter key, and then continue typing.

ANSWER: press the Down Arrow key, and then continue typing.

ANSWER: press the Right Arrow key, and then continue typing.

15.  What does the default layout for a new slide contain?

TYPE: Multiple Choice

ANSWER: One "title" placeholder and two "bulleted list" placeholders.

ANSWER: Two "title" placeholders.

ANSWER: One "title" placeholder and one "bulleted list" placeholder.

ANSWER: Two "title" placeholders and one "bulleted list" placeholder.

16.  In this picture, you can delete the character "n" by pressing:

TYPE: Multiple Choice
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ANSWER: the Delete key

ANSWER: the Backspace key

ANSWER: the Left Arrow key

ANSWER: the Right Arrow key

17.  You can move text between different slides.

TYPE: True or False

ANSWER: True
18.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can move or copy a part of the text without first selecting it.

ANSWER: You can copy a part of the text from one slide to another.

ANSWER: You can delete a part of the text by first selecting it, and then pressing the Delete key.

ANSWER: You can replace a part of the text by first selecting it, and then typing over it.

19. PowerPoint's default location for saving documents is:

TYPE: Multiple Choice

ANSWER: the "Favorites" folder.

ANSWER: the "My Download Files" folder.

ANSWER: the "Web" folder.

ANSWER: the current user's "Documents" folder.

20. Which of the following statements is true?

TYPE: Multiple Choice

ANSWER: As soon as you modify a file, PowerPoint will automatically save it.

ANSWER: You may save a file as a new file without replacing the original one.

ANSWER: You can only save a file once.

ANSWER: You can only modify a file once.

21.  To save a file in a particular folder:

TYPE: Multiple Choice

ANSWER: you must first exit PowerPoint and open that folder using "Windows Explorer."

ANSWER: you must first open a file already saved in that folder.

ANSWER: you must first type in the folder's name in the "File name" box of the "Save as" dialog box.
ANSWER: you must first set the "Save in" location in the "Save as" dialog box to that folder.

22.  In this picture, if the "Save" button is clicked, where will the file be saved?

TYPE: Multiple Choice
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ANSWER: The "Budgets" folder

ANSWER: The "Company" folder
ANSWER: The "Projects" folder

ANSWER: None of the above.

23. When you create a new blank presentation,

TYPE: Multiple Choice

ANSWER: PowerPoint will automatically format it based on previous files you've created.

ANSWER: PowerPoint will close all other files that may be open.

ANSWER: PowerPoint will automatically save it.

ANSWER: a blank slide will appear in the Slide pane.

24.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can open a previously saved file to view and modify it.

ANSWER: You can open a file using its file icon, without having to first start PowerPoint.

ANSWER: You can open a file within PowerPoint using the "Open" function.

ANSWER: When you click on the "Office" button, the names of all the presentations that are saved on your computer will be displayed in the "Recent Documents" list.
25.  What function do the buttons shown in the picture perform?

TYPE: Multiple Choice
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ANSWER: Set the file's margins.

ANSWER: Switch between multiple open files.

ANSWER: Resize the view.

ANSWER: Set the view type.

26.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: The default view is the "Normal" View.

ANSWER: The "Slide Sorter" view displays the sequence of slides in the presentation.

ANSWER: The "Normal" view displays the presentation the way it will appear to the audience.

ANSWER: The "Slide Show" view displays the current slide in full screen.

27. All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can select a view type from the "View" tab.

ANSWER: You can select a view type by using the "View" buttons located at the bottom of the PowerPoint window.
ANSWER: You can resize the view by changing the "Zoom" button.

ANSWER: If you enlarge the view, all the text in the slide will appear larger when printed.

28. You can move or copy the slides in a presentation only in the "Slide Sorter" view.

TYPE: True or False

ANSWER: False
B1.37  Quiz 1-2

Note:  The correct answer for each question is underlined.

1.  All of the following statements are true except one. Which one is FALSE?
TYPE: Multiple Choice

ANSWER: You can use a picture in a file as a slide background.

ANSWER: You can use a color gradient color as a slide background.

ANSWER: You can use a texture as a slide background.

ANSWER: All slides in a presentation must have the same background.
2.  What would happen if the button shown in the picture is clicked?

TYPE: Multiple Choice
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ANSWER: The text will be deleted.

ANSWER: The "Bullet and Numbering" dialog box will open.

ANSWER: Numbering will be applied to the selected lines. 

ANSWER: Bullets will be applied to the selected lines.

3.  All of the following statements are true except one. Which one is FALSE?
TYPE: Multiple Choice

ANSWER: You can change the font type of a slide's text.

ANSWER: All of the text in a slide must have the same font.
ANSWER: Fonts can have different styles.

ANSWER: Fonts are identified by name.

4.  Which of the following is NOT a font style? 

TYPE: Multiple Choice

ANSWER: Arial

ANSWER: Bold

ANSWER: Italic

ANSWER: Bold and Italic

5. All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: The color of the text in a placeholder always has to be black.
ANSWER: You can change the size of the text in a placeholder without changing the size of the placeholder itself.

ANSWER: You can increase the spacing between the text characters in placeholder.

ANSWER: You can apply a shadow effect to the text in placeholder.
6.  In this picture, what will happen to the text if you click on the button highlighted by the red square?

TYPE: Multiple Choice
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ANSWER: The text will be aligned to the left.

ANSWER: The text will be aligned to the right.

ANSWER: The text will be aligned to the center.

ANSWER: Nothing will happen.

7.  In this picture, what will happen to the text if you click on the button highlighted by the red square?

TYPE: Multiple Choice

[image: image13.png]dings) -[60 -

I e § 2|
A [[Z)

Font 5





ANSWER: The text will be aligned to the left.

ANSWER: The text will be aligned to the right.

ANSWER: The text will be aligned to the center.

ANSWER: Nothing will happen.

8.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: The "Mini Toolbar" appears next to selected text in your presentation.

ANSWER: The "Mini Toolbar" lets you change the text's font type and size.

ANSWER: You can activate the "Mini Toolbar" by moving the mouse pointer over it.

ANSWER: Once the "Mini Toolbar" is activated, it will remain on the screen until you close the presentation.
9.  What would happen if the button shown in the picture is clicked?

TYPE: Multiple Choice
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ANSWER: The text will be deleted.

ANSWER: The "Bullet and Numbering" dialog box will open.

ANSWER: Numbering will be added next to the bullets in the selected lines.

ANSWER: Numbering will be applied to the selected lines and the bullets will be removed. 

10.  The "Format Painter" lets you: 

TYPE: Multiple Choice

ANSWER: copy the format of one part of the text and apply it to another.

ANSWER: add a picture to your slide.  

ANSWER: paint the slide's text any color that you like.

ANSWER: paint the slide's background any color that you like.

11.  What would happen if you double-click on the Format Painter instead of single-click?

TYPE: Multiple Choice

ANSWER: The Format Painter button will be removed from the toolbar.

ANSWER: All the text in the current slide will be formatted based on the formatting of the selected text.

ANSWER: The Format Painter will stay active so you can apply the formatting of the selected text to several other parts of the text.

ANSWER: Double-clicking on the Format Painter serves no purpose.

12.  The "Live Preview" feature allows you to:
TYPE: Multiple Choice

ANSWER: see how a presentation's slides will look when printed.  

ANSWER: see how a presentation's slides will look in a slide show.

ANSWER: see how the text in a slide will look with a new format before you apply the format to it.
ANSWER: change the size of a presentation's slides during a slide show.

B1.54 Quiz 1-3

Note:  The correct answer for each question is underlined.

1.  In this picture, where do you have to click first if you want to highlight the slide's title?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: D

2.  In this picture, where do you have to click first if you want to view a slide show of your presentation?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: D

3.  In this picture, where do you have to click first if you want to end the slide show?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: D

4.  What is the function of the "Office Clipboard" task pane??

TYPE: Multiple Choice

ANSWER: It lets you find and insert a clip art in your presentation.

ANSWER: It lets you select a layout for the slides.

ANSWER: It displays the list of items that were recently copied, and lets you paste any one of them into your presentation.
ANSWER: None of the above.

5.  Is there a way to save a PowerPoint file as a slide show so that it can be opened later without using the PowerPoint application? If so how?

TYPE: Multiple Choice

ANSWER: Yes. Simply click on the "Save" button. Then save the file in the desired location.

ANSWER: Yes. Click on the "Office" button, move the mouse pointer over "Save As" and select "PowerPoint Show" from the submenu. Then save the file in the desired location.

ANSWER: Yes. Click on the "Office" button, and select "Save." Then save the file in the desired location. 

ANSWER: No. You always need to use the PowerPoint application to display slide show.
6.  All of the following statements are true about printing slides except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: The "Notes" format prints the notes for multiple slides on a single sheet of paper.

ANSWER: The "Slides" format prints each slide in the presentation on a separate sheet of paper.

ANSWER: The "Handout" format prints multiple slides on a single sheet of paper.

ANSWER: The "Outline" format prints an outline summary of the presentation's contents.

7.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: The "Print Preview" function lets you preview how the presentation will appear in print.

ANSWER: You can specify how many copies of the slides you want to print in the "Print" dialog box. 

ANSWER: You can specify the range of slides you want to print in the "Print" dialog box.

ANSWER: When you print the slides, the handouts and notes pages will be printed as well.

8.   In this picture of the Print dialog box, what will be printed if we keep the current settings?
TYPE: Multiple Choice
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ANSWER: All the slides, notes and handouts will be printed.
ANSWER: Only the current slide will be printed.
ANSWER: All the slides will be printed.
ANSWER: The notes and handouts for all the slides will be printed.
9.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can use the "Office Clipboard" to draw images and add them to your presentation.
ANSWER: You can clear all the items in the "Office Clipboard" at once.

ANSWER: You can use the "Office Clipboard" to paste an item that you have recently moved or copied. 

ANSWER: You can open the "Office Clipboard" by clicking on its dialog box launcher in the "Home" tab.

10.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: If you click on the "Home" button in the "Help" window, the main help page containing the help categories will be displayed.

ANSWER: The "Change Font Size" button in the "Help" window lets you change the size of the text displayed in the window.  

ANSWER: If you click on the "Table of Contents" button in the "Help" window, a list of help categories will be displayed. 

ANSWER: If you click on the "Print" button in the "Help" window, the contents of the current slide will be printed.
11 All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can add notes to the "Notes" pane below the slide.

ANSWER: The notes that you add to the slides will appear on the screen during your presentation.

ANSWER: You can add a different note to each slide in your presentation.

ANSWER: You can print the presentation's notes pages.
B2.13  Quiz 2-1

Note:  The correct answer for each question is underlined.

1.  In the picture, what will happen if you click where the arrow is pointing to?

TYPE: Multiple Choice
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ANSWER: A new slide will appear.

ANSWER: A clip art image will be inserted in the slide.

ANSWER: A text box will be added to the slide.

ANSWER: Nothing will happen.

2.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can format the text in a text box similar to the text in a regular placeholder.

ANSWER: You can rotate a text box to make its text appear in different directions.

ANSWER: You can drag a text box to the desired location in a slide.

ANSWER: The amount of text that you type in a text box is limited to the original size of the textbox. 

3.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can apply a color to a placeholder's background.

ANSWER: You can apply a color to a placeholder's border line.

ANSWER: You can change the thickness of a placeholder's border line.

ANSWER: You can apply a style to a placeholder but not to a text box.
4.  Tabs are used to make a column of text accurately line up in a slide.

TYPE: True or False

ANSWER: True

5.  To line up a part of a text under the next tab stop, you must: 

TYPE: Multiple Choice

ANSWER: select the text and press the Tab key.

ANSWER: place the insertion point at the beginning of the text, and press the Tab key.

ANSWER: place the insertion point at the end of the text, and press the Tab key.

ANSWER: place the insertion point anywhere in the text, and press the Tab key. 

6.  To set a tab stop for the text in a placeholder, you must:

TYPE: Multiple Choice

ANSWER: click on the horizontal ruler at the desired position.

ANSWER: drag the left indent marker to the desired position.

ANSWER: drag the right indent marker to the desired position.

ANSWER: press the Tab key.

7.  Slide numbers can be placed:

TYPE: Multiple Choice

ANSWER: inside the Header or Footer.

ANSWER: below the Header or Footer.

ANSWER: above the Header or Footer.

ANSWER: anywhere in a slide outside the placeholders.

8.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can insert a tab after another tab. 

ANSWER: You can delete a tab the same way you delete a text character.

ANSWER: You can change the position of a tab stop that you have set previously.

ANSWER: The default tab is the "center" tab. 

9.  How can you open the "Header and Footer" dialog box?
TYPE: Multiple Choice

ANSWER: Click on the "Insert" tab and then on the "Header and Footer" button.

ANSWER: Click on the "Home" tab and then on the "Layout" button.

ANSWER: Click on the "View" tab and then on the "Header and Footer" button.

ANSWER: Click on the "Design" tab and then on the "Page Setup" button.
10.  The header and footer dialog box lets you add all of the following to your presentation except one. Which one can not be added?

TYPE: Multiple Choice

ANSWER: date and time

ANSWER: slide numbers

ANSWER: header or footer text

ANSWER: a sound clip

11.  In this picture, what is the item that the red arrow is pointing to?

TYPE: Multiple Choice
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ANSWER: Left indent marker 

ANSWER: Tab stop

ANSWER: Insertion point

ANSWER: Header

12.  The information in the header and footer will appear on:

TYPE: Multiple Choice

ANSWER: only the first slide of the presentation.

ANSWER: only on slides that contains a title placeholder.

ANSWER: the selection you make: either on all the slides or only on the current slide.

ANSWER: only the last slide of the presentation.

13.  In the picture, where do you have to click first in order to check your presentation for spelling errors?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: None of the above

14.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: The "Spelling" function always selects the right suggestion for correcting a spelling error.

ANSWER: The "Spelling" function provides a list of suggestions for correcting a spelling error.

ANSWER: The "Spelling" function lets you correct a spelling error that exists in several places in the presentation at once.

ANSWER: The "Spelling" function lets you find the spelling errors in the presentation's slides and notes.

15.  You can enter information in the header and footer of the notes pages and handouts.

TYPE: True or False

ANSWER: True

16.  In the picture, what will happen if you click where the arrow is pointing to?

TYPE: Multiple Choice
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ANSWER: All instances of the error found will be replaced with the selected correction.

ANSWER: The error will be replaced with the selected correction, and the next error in the presentation will be found.

ANSWER: All errors in the presentation will be corrected.

ANSWER: Nothing will happen.

17.  In this picture, what will happen if you click on the "Replace All" button?
TYPE: Multiple Choice
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ANSWER: The word "area" will be replaced with the word "region" throughout the presentation.

ANSWER: The word "region" will be replaced with the word "area" throughout the presentation.

ANSWER: The word "area" will be replaced with the word "region", and the word "region" will be replaced with the word "area" throughout the presentation.

ANSWER: Nothing.

B2.32  Quiz 2-2

Note:  The correct answer for each question is underlined.

1.  How can you open the "Clip Art" task pane?

TYPE: Multiple Choice

ANSWER: Click on the "Insert" tab and then click on the "Clip Art" button.
ANSWER: Click on "Design" tab and then click on the "Clip Art" button.

ANSWER: Click on the "Pictures" tab and then click on the "Clip Art" button.

ANSWER: Click on the "Clip Art" tab and then click on the "Open" button.
2.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: Clip art refers to pre-designed images that can be inserted in a presentation.

ANSWER: PowerPoint includes several categories of clip art.

ANSWER: To insert a clip art in a slide, you must first delete all the placeholders in the slide. 

ANSWER: You can insert a picture saved in a file into a presentation.
3.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can resize a picture you've inserted in a slide. 

ANSWER: You can crop a picture you've inserted in a slide.

ANSWER: You can move a picture you've inserted in a slide to a different location. 

ANSWER: Resizing and cropping have the same effect on a picture.

4. In this picture of a clip art, dragging the small square that the red arrow is pointing to will:

TYPE: Multiple Choice
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ANSWER: change only the height of the clip art.

ANSWER: change only the width of the clip art.

ANSWER: change both the width and height of the clip art.

ANSWER: make the clip art disappear.

5.  In this picture, which button allows you draw a straight line?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: None of the above
6.  In this picture, which button allows you to draw a circle?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: None of the above
7.  In this picture, which button allows you to draw an oval?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: None of the above
8.  In this picture, which button allows you to draw a square?

TYPE: Multiple Choice
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ANSWER: A

ANSWER: B

ANSWER: C

ANSWER: None of the above

9. In this picture, we have drawn a blue rectangle and a red triangle. Which of the following statements is correct?

TYPE: Multiple Choice
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ANSWER: The blue rectangle is in front of the red triangle. 

ANSWER: To bring the blue rectangle to the front, first select it, click on the "Bring to Front" button in the Format tab.
ANSWER: To bring the blue rectangle to the front, first select it, click on the "Fill" button and then double click on the red triangle.

ANSWER: The blue rectangle is behind the red triangle, and there is no way to bring it to the front.

10. In this picture, which button allows you to add a color to the outline of the drawing?
TYPE: Multiple Choice
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ANSWER: A 

ANSWER: B

ANSWER: C 

ANSWER: None of the above
11. All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can add color to a drawing.

ANSWER: You can add shadow to a drawing.

ANSWER: You can apply a style to a drawing.

ANSWER: You can enter text outside a drawing but not inside it.
12.  In this picture, what will happen if you click on the cell containing the word "Price"?

TYPE: Multiple Choice
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ANSWER: The cell will be deleted.

ANSWER: A border will appear around the cell.

ANSWER: The insertion point will be placed in the cell.

ANSWER: Nothing will happen.

13. When entering text in a table, which key on the keyboard do you need to press to move the insertion point to the next cell?  
TYPE: Multiple Choice

ANSWER: The "Enter" key

ANSWER: The "Shift" key

ANSWER: The "Alt" key

ANSWER: The "Tab" key
14.  All of the following statements are true except one. Which one is FALSE?

TYPE: Multiple Choice

ANSWER: You can add new data to an existing chart.

ANSWER: You can change a chart's type to present its data in a different way.

ANSWER: When you change the data included in a chart, you need to "redraw" the chart to update its contents.
ANSWER: You can move a chart within the slide.

15.  Which of the following statements is true?

TYPE: Multiple Choice

ANSWER: To deselect a chart, you can click anywhere inside it.

ANSWER: PowerPoint provides only one chart type.

ANSWER: You cannot move a chart by dragging it.

ANSWER: You can add a chart to a slide by clicking on the "Chart" button from the "Insert" tab.

16.  After inserting a chart in a slide, how can you get to the dialog box that let's you change the chart's type?

TYPE: Multiple Choice

ANSWER: You can insert either a movie or a sound in a presentation, not both.

ANSWER: When you insert a sound in a slide, the sound will be automatically added to all other slides in the presentation.

ANSWER: When you insert a movie in a slide, you can make the movie start automatically when the slide is displayed in a slide show.
ANSWER: To insert a movie in a slide, you must first erase all the slide's contents.
B2.44  Quiz 2-3

Note:  The correct answer for each question is underlined.

1.  In this picture, what will happen if you select the layout pointed to by the red arrow?

TYPE: Multiple Choice
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ANSWER: The current slide's layout will change to the selected layout.

ANSWER: A new slide with the selected layout will be added to the presentation.

ANSWER: A new presentation will be created and all its slides will have the selected layout.

ANSWER: None of the above
2. If you change a slide's layout, any text that has already been entered in the slide will be erased.

TYPE: True or False

ANSWER: False
3.  All of the following statements are true except one. Which one is FALSE?


TYPE: Multiple Choice

ANSWER: If you insert a picture in the slide master, the picture will appear on all the slides in the presentation.

ANSWER: The slide master lets you specify the desired font settings for the slide titles, subtitles and bulleted lists.

ANSWER: The font settings you specify for the slide master will appear on all the slides.

ANSWER: The slide master lets you select a pre-defined template for your presentation.

4.  What is a "Theme?"
TYPE: Multiple Choice

ANSWER: A set of textures that you use as slide backgrounds. 

ANSWER: A set of slide layouts that you can use in a presentation. 

ANSWER: A set of colors, fonts and effects that gives a specific look to a presentation.

ANSWER: A set of styles that you can apply to the drawings in a presentation.
5.  What are "Templates" used for in PowerPoint?
TYPE: Multiple Choice

ANSWER: They are used to insert a movie or sound in a presentation.

ANSWER: They are used to import pictures or clip arts in a presentation.

ANSWER: "Templates" are not used in PowerPoint.

ANSWER: They are used for creating professional looking presentations with a pre-designed, ready-to-use formatting.
6. You can modify an existing template and save it as a new template.

TYPE: True or False

ANSWER: True
7.  What are "slide transitions" used for?

TYPE: Multiple Choice

ANSWER: They are used for entertaining the audience until the presentation actually starts.

ANSWER: They are used for converting the contents of a slide into an Excel spreadsheet.
ANSWER: They are used for converting the contents of a slide into a Word document format. 

ANSWER: They are used for making the transition between slides in a slide show more interesting.

8. A slide transition may include a sound.

TYPE: True or False

ANSWER: True
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